IBM WebSphere Application Server V6.0 Administration

(Course Code SW246)

Lab Setup Guide

ERC 6.0

WebSphere Training and Technical Enablement
Trademarks

IBM® is a registered trademark of International Business Machines Corporation.

The following are trademarks of International Business Machines Corporation in the United States, or other countries, or both:

AIX® developerWorks® HACMP™ Tivoli®
Cloudscape™ Domino® Passport Advantage® WebSphere®
DB2® e-business on demand™ Rational® z/OS®

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or both.

Intel is a trademark of Intel Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product and service names may be trademarks or service marks of others.

March 2005 Edition

The information contained in this document has not been submitted to any formal IBM test and is distributed on an “as is” basis without any warranty either express or implied. The use of this information or the implementation of any of these techniques is a customer responsibility and depends on the customer’s ability to evaluate and integrate them into the customer’s operational environment. While each item may have been reviewed by IBM for accuracy in a specific situation, there is no guarantee that the same or similar results will result elsewhere. Customers attempting to adapt these techniques to their own environments do so at their own risk.

© Copyright International Business Machines Corporation 2002, 2005. All rights reserved.
This document may not be reproduced in whole or in part without the prior written permission of IBM.
Note to U.S. Government Users — Documentation related to restricted rights — Use, duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corp.
# Contents

## Trademarks

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>v</td>
</tr>
</tbody>
</table>

## Purpose

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>vii</td>
</tr>
</tbody>
</table>

## Requirements (Windows)

<table>
<thead>
<tr>
<th>Hardware requirements</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software requirements</td>
<td>1</td>
</tr>
<tr>
<td>Product documentation requirements</td>
<td>3</td>
</tr>
<tr>
<td>Special materials requirements</td>
<td>3</td>
</tr>
<tr>
<td>Skills required to set up the lab</td>
<td>3</td>
</tr>
</tbody>
</table>

## Setup instructions (Windows)

<table>
<thead>
<tr>
<th>Configuration information</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware setup instructions</td>
<td>5</td>
</tr>
<tr>
<td>Software setup instructions</td>
<td>5</td>
</tr>
<tr>
<td>Verification procedures</td>
<td>9</td>
</tr>
</tbody>
</table>

## Requirements (AIX)

<table>
<thead>
<tr>
<th>Hardware requirements</th>
<th>15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software requirements</td>
<td>15</td>
</tr>
<tr>
<td>Product documentation requirements</td>
<td>16</td>
</tr>
<tr>
<td>Special materials requirements</td>
<td>16</td>
</tr>
<tr>
<td>Skills required to set up the lab</td>
<td>17</td>
</tr>
</tbody>
</table>

## Setup instructions (AIX)

<table>
<thead>
<tr>
<th>Configuration information</th>
<th>19</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware setup instructions</td>
<td>19</td>
</tr>
<tr>
<td>Software setup instructions</td>
<td>19</td>
</tr>
<tr>
<td>Verification procedures</td>
<td>25</td>
</tr>
</tbody>
</table>

## Requirements (Linux)

<table>
<thead>
<tr>
<th>Hardware requirements</th>
<th>27</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software requirements</td>
<td>27</td>
</tr>
<tr>
<td>Product documentation requirements</td>
<td>29</td>
</tr>
<tr>
<td>Special materials requirements</td>
<td>29</td>
</tr>
<tr>
<td>Skills required to set up the lab</td>
<td>29</td>
</tr>
</tbody>
</table>

## Setup instructions (Linux)

<table>
<thead>
<tr>
<th>Configuration information</th>
<th>31</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware setup instructions</td>
<td>31</td>
</tr>
<tr>
<td>Software setup instructions</td>
<td>31</td>
</tr>
<tr>
<td>Verification procedures</td>
<td>40</td>
</tr>
</tbody>
</table>
Trademarks

The reader should recognize that the following terms, which appear in the content of this training document, are official trademarks of IBM or other companies:

IBM® is a registered trademark of International Business Machines Corporation.

The following are trademarks of International Business Machines Corporation in the United States, or other countries, or both:

AIX®, developerWorks®, HACMP™, Tivoli®, Cloudscape™, Domino®, Passport Advantage®, WebSphere®, DB2®, e-business on demand™, Rational®, z/OS®

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or both.

Intel is a trademark of Intel Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product and service names may be trademarks or service marks of others.
Purpose

This Lab Setup Guide provides directions for installing, preparing, and verifying the lab hardware and software in preparation for conducting a class of course SW246.

The Requirements sections of this document may also be used to determine the specific hardware and software needed to conduct a class.
Requirements (Windows)

The following tables list the hardware, software, and other materials needed to set up a lab to conduct a class of course SW246.

Hardware requirements

Table 1 lists the hardware needed to prepare one student lab set. When preparing for a class, multiply the items below by the number of lab sets needed for the class.

Table 1: Hardware for one student lab set

<table>
<thead>
<tr>
<th>Platform Use</th>
<th>Machine Requirements</th>
<th>Minimum Memory</th>
<th>Minimum Disk Space</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student</td>
<td>Pentium 1 Ghz</td>
<td>1 GB</td>
<td>12 GB</td>
<td>CD-ROM Network adapter</td>
</tr>
<tr>
<td>Instructor</td>
<td>Pentium 1 Ghz</td>
<td>1 GB</td>
<td>12 GB</td>
<td>CD-ROM Network adapter</td>
</tr>
</tbody>
</table>

Software requirements

Table 2 lists the software needed to prepare the student and instructor lab sets. When preparing for a class, be sure you have the correct number of licensed copies of any non-IBM software.

Table 2: Software for student and instructor systems

<table>
<thead>
<tr>
<th>Platform Use</th>
<th>Operating System</th>
<th>OS Version</th>
<th>Applications</th>
<th>Application Version</th>
<th>Licensing Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student</td>
<td>Windows 2000 Professional</td>
<td>Service Pack 4</td>
<td>Internet Explorer</td>
<td>Version 5.5, Service Pack 2 or newer version</td>
<td>Site must provide for private offering</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IBM DB2 UDB*</td>
<td>Version 8.2 (same as Version 8.1 FixPak 7a)</td>
<td></td>
</tr>
</tbody>
</table>
Table 2: Software for student and instructor systems

<table>
<thead>
<tr>
<th>Platform Use</th>
<th>Operating System</th>
<th>OS Version</th>
<th>Applications</th>
<th>Application Version</th>
<th>Licensing Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>IBM WebSphere Application Server Network Deployment *</td>
<td>V6 (as Installation Image)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Application Server Toolkit (AST) *</td>
<td>V 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Adobe Acrobat Reader</td>
<td>5.0 or above</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>WinZip or equivalent</td>
<td>7.0 or above</td>
<td></td>
</tr>
<tr>
<td>Course Lab files</td>
<td></td>
<td></td>
<td>SW246v6_software.zip</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Post Installation files for Imaging</td>
<td></td>
<td></td>
<td>SW246v6_software_CDs.zip</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Instructor</td>
<td>Same as Student system</td>
<td></td>
<td>RenameHost.zip</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Both Course Lab files and the Post-Installation file are packaged as one zip file: SW246labfiles.zip.

* Follow your normal policies and procedures regarding obtaining licensed software. IBM employees may wish to use the Software Downloads section at Xtreme Leverage Portal (w3.ibm.com/software/websphere).

Search for “WebSphere Application Server Network Deployment V6.0 Multiplatform eAssembly”.

Table 3 shows file names from the downloaded e-Assembly. If you are installing from CDs, use the appropriate installation disk instead.

Table 3: Main IBM software images

<table>
<thead>
<tr>
<th>File name</th>
<th>Part of WAS6 ND</th>
</tr>
</thead>
<tbody>
<tr>
<td>C587UML.zip</td>
<td>WebSphere Application Server Network Deployment V6.0 Application Server IBM HTTP Server Web server plug-ins DataDirect JDBC Drivers Application Clients for XP and Windows 2000 (Multilingual)</td>
</tr>
</tbody>
</table>
Special materials requirements

This table lists the tools the instructor and students can use during the class. Quantities are specified for the entire class.

Table 4: Tools recommended for class

<table>
<thead>
<tr>
<th>Tools</th>
<th>Files</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>recommended</td>
<td>gnu utilities for Windows</td>
<td></td>
</tr>
<tr>
<td>recommended</td>
<td>gnu_utils.zip</td>
<td></td>
</tr>
<tr>
<td>recommended</td>
<td>WebSphere Help System</td>
<td></td>
</tr>
<tr>
<td>recommended</td>
<td>WAS6DN DOC</td>
<td></td>
</tr>
<tr>
<td>recommended</td>
<td>IHS V6 DOC</td>
<td></td>
</tr>
<tr>
<td>recommended</td>
<td>webSphere_help_system_212_win.zip</td>
<td>V 2.1.2</td>
</tr>
<tr>
<td>recommended</td>
<td>com.ibm.websphere.nd.doc.zip</td>
<td>V 6</td>
</tr>
<tr>
<td>recommended</td>
<td>com.ibm.websphere.ihs.doc.zip</td>
<td>V 6</td>
</tr>
</tbody>
</table>

The gnu_utils and the WebSphere Help System are part of the SW246v6_software_CDs.zip package.

To download the newest WebSphere Help System and the Offline InfoCenter Documentation go to the following Web site: http://www.ibm.com/software/webservers/appserv/library.html.

Product documentation requirements

None

Special materials requirements

None

Skills required to set up the lab

The following specialized skills are required to set up the lab.

- Familiarity with installing Windows 2000 and DB2.
Setup instructions (Windows)

Configuration information

The following describes the configurations of the student and lab set systems.

The ideal classroom configuration is to have all student machines connected to the same LAN with TCP/IP correctly configured so that machines can connect to each other using their host names. Internet access is recommended.

If no LAN adapter is available, the Microsoft Loopback Adapter should be configured as the default LAN adapter with a private TCP/IP address so that the TCP/IP stack will be active.

Each student machine should be able to be used stand-alone and MUST have all of the products required for the labs installed locally.

Hardware setup instructions

No special instructions.

Software setup instructions

Use the following information in addition to the normal software installation procedures to set up the lab software.

*Install and configure Windows*

_1. During Windows 2000 installation:

   • Create a single C: partition and install Windows 2000 and all other products on this partition.
   • Set the password for Administrator user to was1edu (lower case).
   • Choose a computer name of was6hostXX (where XX is 01, 02, and so forth). Note: Do not include an underscore (_) character or other symbol characters in the computer name because this will result in an invalid TCP/IP host name and some products will fail.
   • Update Norton virus definitions and get Microsoft Windows updates if necessary.

_2. If there is no LAN adapter, install the Microsoft Loopback Adapter

   • Use the Add/Remove Hardware Wizard in Control Panel to install the Microsoft Loopback Network Adapter and configure it with a private IP address (such as 10.1.1.1).
• Use Network and Dial-up Connections to set this new LAN connection for the Microsoft Loopback Adapter as the first connection. Click **Start -> Settings -> Network and Dial-up Connections**. Select **Advanced -> Advanced Settings**. Select the connection that was just added for the Microsoft Loopback Adapter (for example Local Area Connection 2). Click the up arrow to move this to the top of the Connections list. Click **OK**.

3. Check or edit the hosts file and add an alias for your computer name and IP address. If you installed the Microsoft Loopback Adapter, add the IP address for that adapter. If you are LAN connected, and the host names for the classroom machines cannot be resolved via DNS, add the IP address and host names of the other classroom machines.

   • Edit `C:\winnt\system32\drivers\etc\hosts`.
   
   • Add a line like the following for each IP address/host name combination:

   
   ```
   10.1.1.1 was6host01
   ```

4. Remove the default DNS suffix for the computer name (hostname).

   • Right-click **My Computer** icon on desktop. Select **Properties -> Network Identification -> Properties**. Check the **Computer name**: was6hostXX, **Member of Workgroup** (for example, Workgroup). Click **More...** and make sure the **Primary DNS suffix** is blank.

5. Use the **System** applet in **Control Panel** to set the paging file size to a minimum size of 1 GB and a maximum of 2 GB.

6. Use the **Users and Passwords** applet in **Control Panel** to create a user **userid** in the Administrators group and set its password to **was1edu** (lower case). Set Password never expires.

7. Modify the **User Rights Assignment** so that **userid** can **Act as part of the operating system**.

   a. Open the **Administrative Tools** applet from the control panel.

   b. Open the **Local Security Policy** applet.

   c. Expand **Local Policies**, and select **User Rights Assignment**.

   d. Open the **Act as part of the operating system** policy (it should be the second one in the list).

   e. Click the **Add...** button.

   f. Select **userid** from the list of users.

   g. Click the **Add** button.

   h. Click the **OK** button.

   i. Click the **OK** button.

8. Restart the machine and log in as **userid** before performing other installation steps.
9. Setup Internet Explorer to connect through a local area without proxy.
   - Run desktop icon “Connect to the Internet” and select (option 3): “I want to set up my Internet connection manually...” Click next.
   - Select (option2): “I connect through a local area network (LAN)”. Click next.
   - All check boxes should be unselected (you may have to disable “Automatic discovery...”). Click next.
   - Select No for Setting up an Internet mail account. Click next and finish.

10. Install Winzip and Adobe Acrobat Reader with default or classic settings

11. Optional: Copy short cut of Command Prompt and Services to the desktop
(Start -> Programs -> Accessories -> Command Prompt;
Start -> Settings -> Control Panel -> Administrative Tools -> Services)

Install DB2 UDB V8.2

For the correct level of JDBC support the labs require DB2 Enterprise Server Edition Version 8.2 (you can also use Version 8.1 with Fixpack 7a).

1. Install DB2 V8.2. Run setup.exe from CD-ROM or the <DB2 Install> directory.

2. Select Install Product from menu.


4. After a few moments the setup wizard appears with Welcome screen. Click Next>.

5. Accept the agreement terms. Click Next>.

6. Choose a Typical installation to install the default components. Click Next>.

7. After some seconds make sure, that Install DB2 Enterprise Server Edition on the computer is selected, click Next>.

8. Take the default installation folder (C:\Program Files\IBM\SQLLIB\). Click Next>.

9. Accept defaults for domain and user name for the DB2Administration Server and add the correct password was1edu:
   - Domain: leave blank
   - User name: db2admin
   - Password: was1edu
   - Confirm password: was1edu
   - Select Use the same user name and password for the remaining DB2 services.
   - Click Next>

10. Accept the default for Administration contact list location - Local. Click Next>.
__ 11. Click OK to accept the Warning about Notification SMTP server.
__ 12. Accept the default instance DB2. Click Next>.
__ 13. Do not prepare DB2 tools catalog. Click Next>.
__ 14. Select Defer the task until after installation is complete for Administration contact. Click Next>.
__ 15. Review the Start copying files screen, click Install. Click Finish when setup is completed.

**Install WebSphere Application Server ND V6 Application Server Toolkit V6 (AST)**

__ 1. Invoke setup.exe program from the CD or the <AST_install> directory.
__ 2. Click Next> on Welcome screen.
__ 3. Accept the Software License Agreement. Click Next>.
__ 4. Accept the default installation directory (C:\Program Files\IBM\WebSphere\AST). Click Next>.
__ 5. Click Next> on the Summary page and install the product.
__ 6. Click Finish and exit the installation.
__ 7. Copy the AST shortcut to the desktop (Start -> Programs -> IBM WebSphere -> IBM WebSphere Application Server Toolkit, V6.0 -> Application Server Toolkit).

**Copy installation images and additional files**

__ 1. Create a new C:\Tempdir directory.
__ 2. Unzip the SW246labfiles.zip to C:\Tempdir. There should be three zip files.
__ 3. Unzip the files and folders from the C:\Tempdir\SW246v6_softwareCDs.zip to the C:\ folder. This will create the C:\Software_CDs folder.
__ 2. Copy the contents of the WebSphere Application Server ND V6.0 CD to the C:\Software_CDs\WAS6 directory. If you are using a zip file of the WebSphere Application Server ND V6.0 product, unpack the content to the C:\Software_CDs\WAS6 folder.
__ 3. Check the contents of the gnu_utils in the C:\Software_CDs\gnu_utils directory.
__ 4. Check the cmdline_completion.reg in the C:\Software_CDs\ directory.
__ 5. Check the WebSphere Help System in the C:\Software_CDs\HelpSystem\ folder:
- webSphere_help_system_212_win.zip
- com.ibm.websphere.nd.doc.zip
- com.ibm.websphere.ihs.doc.zip
Note: If the files not available, you can get them from:
and copy all file to the C:\Software_CDs\HelpSystem folder.

Install sample files

1. Unzip the lab files from the C:\Tempdir\SW246v6_software.zip to the C:\ folder. This will create the C:\Software folder.

Note: This should create a directory structure under C:\Software.

2. Use the System applet in Control Panel to add directory C:\Software_CDs\gnu_utils to the Path system variable. This enables the UNIX utilities (including tail).

Alternative: Copy all files from the C:\Software_CDs\gnu_utils\ folder to the C:\winnt\ directory.

3. Execute the C:\Software_CDs\cmdline_completion.reg. Click Yes and OK.

4. Setup the sample database for the trade application by running the following batch files in the C:\Software\Databases directory:
   - Run batch file CreateDB.bat
   - Check the CreateDB.log file to verify the databases were created and populated correctly.

Verification procedures

Use the following information to verify the installation and configurations of the lab and instructor systems.

1. Start the DB2 Control Center (Start -> Programs -> IBM DB2 -> General Administration Tools -> Control Center).

2. Click OK to specify the Advanced view to display the Control Center.

3. Expand All Databases on the left. The TRADE and QUOTE databases should be listed.

4. Expand QUOTE database and click Tables.
   - Verify that the QUOTE table was created. On the right you find the list of tables with “Name” “Schema”, and so forth. The Schema of QUOTE should be USERID.
   - Still in the Tables view left-click the QUOTE table. Click Open...
   - Verify some sample data was loaded (for example, IBM, AOL, and so forth). Close the Open Table window.
__5. Expand TRADE and select Tables. Verify that the ACCOUNT, ADDRESS, HOLDINGS, PREFS, PROFILE, SYMBOL and TRANSACTIONHISTORY tables were created. Verify some sample data was loaded.

6. Close DB2 Control Center.
Appendix A. Additional setup instructions for IBM course “Ghost” images

In cases where one machine is ghosted and copied to other machines perform the actions in this Appendix.

Before ghosting

If you are creating a ghost image perform the following actions before capturing the image.

__ 1. Log in as userid using was1edu password.
__ 2. Unzip the C:\Tempdir\RenameHost.zip to the C:\ directory. This creates the C:\temp\RenameHost folder.
__ 3. Run the setup.bat in the C:\temp\RenameHost\ directory. This batch file creates a new icon on the Desktop (RenameHost.bat)

After loading a ghost image

After loading the ghost image, you will need to assign a unique hostname to each machine. Perform the following actions for each ghosted machine.

__ 1. Log in as userid using was1edu password.
__ 2. Check for the RenameHost.bat icon on the Desktop.

Note: If the RenameHost.bat icon is present perform the script-based steps by following Option 1 below. If the script files are not available follow the steps in Option 2 to do it manually.

Option 1: Change hostname and DB2 node with script files

__ 1. If the Database Manager is running, stop it. You can use the smart icon on the Windows tray, left click, select Stop (DB2). Or use Start -> Settings -> Control Panel -> Administration Tools -> Services to stop all DB2 services.
__ 2. Run the RenameHost.bat icon on desktop to start the Rename Host Utility program.
__ 3. Leave the Root Name as given (was6host), change the number to XX (where XX is 01, 02, and so forth) and choose which postinstall_scripts to run (all is recommended).
__ 4. Check box Reboot should be selected. Click OK.
__ 5. Click OK to the Confirm Reboot window to reboot the machine.

Option 2: Steps to change hostname and DB2 node manually

__ 1. Edit the hosts file and change the IP addresses as applicable for your network and change the hostname of each machine to coincide with entries in the hosts file:
Edit `c:\winnt\system32\drivers\etc\hosts`

2. Select a suitable hostname and change the IP address accordingly.

3. Change the system name by right-clicking on the My Computer desktop icon and selecting the properties option from the drop down menu.

j. Select the Network Identification tab.

k. Select the Properties button.

l. Enter a computer name from the hosts file (was5host01, and so forth.) Do not close the Identification Changes window.

m. Remove the default DNS suffix for the computer name (hostname).
   - In the Identification Changes window click More... and make sure the Primary DNS suffix is blank.

n. Close all Windows with OK.

4. Reboot the machine

5. Ping various machines to ensure they can communicate

6. Each machine’s DB2 instance needs to be rebuilt in order to properly recognize the hostnames.

NOTE: The course image from IBM contains an instance with no databases preloaded. If you are using this image or you did not run the createDB.bat script in building your own ghost image: /

7. Ensure DB2 is stopped before going on.

8. cd to the C:\Program Files\IBM\SQLLIB\DB2 directory:
   - `cd c:\program files\ibm\sqllib\db2`

9. Edit the file `db2nodes.cfg` to update the hostname:
   - `notepad db2nodes.cfg`

10. Change in the db2nodes.cfg file both instances of the “was6host00” to the correct number (where XX is 01, 02, and so forth):
    - Change “0 was6host00 WAS6HOST00 0” to “0 was6hostXX WAS6HOSTXX 0”
    - Save the file and close Notepad.

11. Using Windows Explorer, check to see that c:\program files\ibm\sqllib\db2\db2nodes.cfg is created with the current time and date.

12. At the command line, enter: `db2start`.

13. Setup the sample database for the trade application by running the following batch file in the C:\Software\Databases directory:
   - Run batch file `CreateDB.bat`
• Check the CreateDB.log file to verify the databases were created and populated correctly.

__ 14. Verify the creation of the database by completing the verification steps at the end of the lab setup guide.
Requirements (AIX)

The following tables list the hardware, software, and other materials needed to set up a lab to conduct a class of course SW246 on AIX.

Hardware requirements

Table 5 lists the hardware needed to prepare one student lab set. When preparing for a class, multiply the items below by the number of lab sets needed for the class.

Table 5: Hardware for one student lab set

<table>
<thead>
<tr>
<th>Platform Use</th>
<th>Machine Requirements</th>
<th>Minimum Memory</th>
<th>Minimum Disk Space</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student</td>
<td>Power PC 375 Mhz min</td>
<td>1 GB</td>
<td>20 GB</td>
<td>CD-ROM, Network adapter</td>
</tr>
<tr>
<td>Instructor</td>
<td>Power PC 375 Mhz min</td>
<td>1 GB</td>
<td>20 GB</td>
<td>CD-ROM, Network adapter</td>
</tr>
</tbody>
</table>

Software requirements

Table 6 lists the software needed to prepare the student and instructor lab set. When preparing for a class, be sure you have the correct number of licensed copies of any non-IBM software.

Table 6: Software for student and instructor systems

<table>
<thead>
<tr>
<th>Platform Use</th>
<th>Operating System</th>
<th>OS Version</th>
<th>Applications</th>
<th>Application Version</th>
<th>Licensing Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student</td>
<td>AIX</td>
<td>5L</td>
<td>Mozilla</td>
<td>Version 1.x</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IBM DB2 UDB*</td>
<td>Version 8.2</td>
<td>(same as Version 8.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>FixPak 7a)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IBM WebSphere</td>
<td>V6 (as Installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Application Server</td>
<td>Image)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Network Deployment *</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Adobe Acrobat Reader</td>
<td>5.0 or above</td>
<td></td>
</tr>
</tbody>
</table>
Note: Both Course Lab files are packaged as one zip file: sw246labfiles_AIX.zip.

The following AIX maintenance levels should be installed:

- AIX 5.1 Maintenance Level (5100-04) or AIX 5.2 Maintenance Level (5100-01) + APAR IY44183

* Follow your normal policies and procedures regarding obtaining licensed software. IBM employees may wish to use the Software Downloads section at Xtreme Leverage Portal (w3.ibm.com/software/websphere).

Search for “WebSphere Network Deployment V6.0 AIX”.

Table 3 shows file names from the downloaded e-Assembly. If you are installing from CDs, use the appropriate installation disk instead.

### Table 7: Main IBM software images

<table>
<thead>
<tr>
<th>File name</th>
<th>Part of WAS6 ND</th>
</tr>
</thead>
<tbody>
<tr>
<td>C58RYML.tar</td>
<td>DB2 UDB Enterprise Server Edition V8.2 for AIX V5L 32- &amp; 64-bit (English, French, German, Italian)</td>
</tr>
</tbody>
</table>

## Product documentation requirements

None

## Special materials requirements

None
Skills required to set up the lab

The following specialized skills are required to set up the lab.

- Familiarity with installing AIX and DB2.
Lab Setup Guide

Setup instructions (AIX)

Configuration information

The following describes the configurations of the student and lab systems.

The ideal classroom configuration is to have all student machines connected to the same LAN with TCP/IP correctly configured so that machines can connect to each other using their host names. Internet access is recommended.

If no LAN adapter is available, the Loopback Adapter (lo) should be configured as the default LAN adapter with a private TCP/IP address (127.0.0.1) so that the TCP/IP stack will be active.

Each student machine should be able to be used stand-alone and must have all of the products required for the labs installed locally.

Hardware setup instructions

No special instructions.

Software setup instructions

Use the following information in addition to the normal software installation procedures to set up the lab software. It is no longer necessary for student systems to communicate with each other for lab purposes so static IP addresses are no longer required. Connection to the internet is not required but may be desirable in some lab situations.

Install and configure AIX

__ 1. During AIX installation:

• Create a single partition and install AIX as appropriate and all other products on this partition.
• Set the password for root user to was1edu (lower case).
• Use was6host00 for the computer name. Note: Do not include an underscore (_) character or other symbol characters in the computer name because this will result in an invalid TCP/IP host name and some products will fail.
• Select DHCP as the IP connection type
• During installation specify and confirm was1edu for the root password
• Install any fixpaks, particularly fixpaks effecting XWindows
• Install rpm package manager for GSKIT support
2. Edit the hosts file and add an alias for your computer name and IP address for the loopback adapter (127.0.0.1). If you are LAN connected configure the machines for internet connection using DHCP (preferred) or use static IP addresses if DHCP is not available:
   — Open a terminal and enter smitty at the command line.
   — Select **Communications Applications and Services** and press **Enter**
   — Select **TCP/IP**
   — Select **Minimum Configuration & Startup**
   — Select the appropriate interface (probably en0)
   — Enter **was6host00** for the Hostname
   — Enter an appropriate IP address, Network Mask, NameServer, and Default Gateway
   — Press the **Enter** key to save
   — Changes should be recorded and presented on the screen. Press F10 to complete and return to the command line
   — Add a line like the following for the static IP address and host name combination:
     
     10.1.1.1  was6host00

3. Ensure that the file systems are allocated with enough space:
   — /usr needs at least 5 Gb
   — /home needs at least 1Gb
   — /tmp needs at least 500 Mb

4. Ensure that these file sets are at the required level or higher:
   For AIX 5.1:
   — X11.fnt.ucs.ttf 5.1.0.1
   — X11.fnt.ucs.ttf_CN 5.1.0.1
   — X11.fnt.ucs.ttf_KR 5.1.0.1
   — X11.fnt.ucs.ttf_TW 5.1.0.1

Create users and groups required for messaging

1. Create the groups mqm and mqbrkrs.
   - As root, at the command line:
     - Enter **mkgroup mqm**
     - Enter **mkgroup mqbrkrs**

2. Create the user mqm and add it to the group mqm.
• As root, at the command line:
  - Enter `mkuser pgrp=mqm home=/home/mqm mqm`

**Create db2admin and userid - set passwd for mqm**

___ 1. Create users **userid** and **db2admin** at the command line:
  • As root, at the command line:
    - Enter `mkuser pgrp=staff home=/home/userid userid`
    - Enter `mkuser pgrp=staff home=/home/db2admin db2admin`

___ 2. Manually set the passwords for **db2admin**, **userid** and **mqm**
  • As root, at the command line:
    - Enter `passwd db2admin`
  • Use **was1edu** as the password
    - Enter `su db2admin`
    - Enter `passwd`
  • Use **was1edu** as the old and new password
    - Enter `exit`
  • Repeat for **userid** and **mqm** using the password **was1edu**

**Install Mozilla Web browser**

___ 3. Install and setup Mozilla to connect through a local area without proxy unless otherwise specified/directed.
  • Download Mozilla for AIX 5.x from http://www.mozilla.org to some temporary directory
  • Download the following packages from the AIX Toolbox for AIX v5.x:
    - libpng
    - libtiff
    - libjpeg
    - glib2
    - gtk
    - pango
  • AIX toolbox located at:

___ 4. Install Adobe Acrobat Reader with default or classic settings
- Download and install **Adobe Acrobat Reader v5.x or newer** for AIX from http://www.adobe.com/
- Follow the instructions at http://www.mozilla.org/ to install the Acrobat plug-in to Mozilla (optional)

__5. Place an icon on the desktop for Mozilla__
- Click **Application Manager** icon on Front Panel
- Double-click **Desktop_Apps** icon
- Double-click **Create Action** icon
- Enter **Mozilla** for Action Name
- Enter path (ie. /usr/mozilla/mozilla) to **Mozilla** command for **Command When Action is Opened**
- Click **File** and then **Save**
- Open the File Manager from the Front Panel
- Double-click the **Mozilla** icon to test it
- Right-click the icon and select **Put in Workspace**

__6. Place Evals icon on the Desktop__
- Close any open browsers
- Click **Application Manager** icon on Front Panel
- Double-click **Desktop_Apps** icon
- Double-click **Create Action** icon
- Enter **Evals** for Action Name
- Enter the following for **Command When Action is Opened**
  `<path to mozilla>` http://qualamer.atlanta.ibm.com/EMEAWeb/EmeaQuality?cmd=selectSurvey
- Click **File** and then **Save**
- Open the File Manager from the Front Panel
- Double-click the **Mozilla** icon to test it
- Right-click the icon and select **Put in Workspace**

__7. Place dtterm icon on the Desktop__
- Double-click **Desktop_Apps**
- Right click **Terminal** and select **Put in Workspace**
- Repeat these steps for **Text Editor**
- Repeat these steps for **Smit** under **System_Admin**
Install DB2 UDB V8.2

For the correct level of JDBC support the labs require DB2 Enterprise Server Edition Version 8.2 (you can also use Version 8.1 with Fixpack 7a).

__1. Install DB2 V8.2. Run ./db2setup from CD-ROM or the <DB2 Install> directory
__2. Select Install Product from menu.
__4. After a few moments the setup wizard appears with Welcome screen. Click Next>.
__5. Accept the agreement terms. Click Next>.
__6. Choose a Typical installation to install the default components. Click Next>.
__7. After some seconds make sure, that Install DB2 Enterprise Server Edition on the computer is selected, click Next>.
__8. Accept defaults for domain and user name for the DB2Administration Server and add the correct password was1edu:
   • Domain: leave blank
   • User name: dasusr1
   • Group name: dasadm1
   • Password: was1edu
   • Confirm password: was1edu
   • Click Next>
__9. Accept the default for creating a DB2 instance. Click Next>.
__10. Select the Single-Partition instance. Click Next>.
__11. Accept defaults for instance user name and add the correct password was1edu:
   • User name: db2inst1
   • Group name: db2grp1
   • Password: was1edu
   • Confirm password: was1edu
   • Click Next>
__12. Accept defaults for fenced user name and add the correct password was1edu:
   • User name: db2fenc1
   • Group name: db2fgrp1
   • Password: was1edu
   • Confirm password: was1edu
   • Click Next>
13. Select **Do Not Prepare Tools Catalog...** option. Click **Next>**.

14. Accept the default for Administration contact list location - **Local** and deselect **Enable notification**. Click **Next>**.

15. Click **OK** to accept the Warning about Notification SMTP server.

16. Select **Defer the task until after installation is complete** for Administration contact. Click **Next>**.

17. Review the Start copying files screen, click **Install**. Click **Finish** when setup is completed.

18. Exit First Steps Launchpad.

19. Edit `/.profile` and add the following lines:

   ```
   # Setup DB2 environment for root user.
   if [ -f /home/db2inst1/sqlليم/db2profile ] ; then
     . /home/db2inst1/sqlليم/db2profile
   fi
   ``

   • Logout and log back in as **root**

**Copy installation images and additional files**

1. As **root** create a new `/usr/tempdir` directory.

2. Use the `unzip` command at the command line to expand the `sw246labfiles_AIX.zip` to the `/usr/tempdir` directory. There should be two zip files.

3. Unzip the files and folders from the `/usr/tempdir/SW246v6_softwareCDs.zip` to the `/usr` folder. This will create the `/usr/software_CDs` folder.

4. Copy the contents of the WebSphere Application Server ND V6.0 for Linux CD to the `/usr/software_CDs/WAS6` directory. If you are using a zip file of the WebSphere Application Server ND V6.0 product, unpack the content to the `/usr/software_CDs/WAS6/` directory.

**Install sample files**

1. Unzip the lab files from the `/usr/tempdir/SW246v6_software.zip` to the `/usr/` folder. This will create the `/usr/software` folder.

   **Note:** This should create a directory structure under `/usr/software`.

2. Setup the sample database for the trade application by running the following batch file in the `/usr/software/Databases` directory:

   • Enter `chmod 755 *.sh` at the command line
   • Run shell script `/createDB.sh` as root
   • Check the `CreateDB.log` file to verify the databases were created and populated correctly.
Verification procedures

Use the following information to verify the installation and configurations of the lab and instructor systems.

1. At the command line enter
   `db2 connect to QUOTE user db2admin using was1edu`

2. Enter `db2 list tables for schema userid`

3. Verify that the QUOTE table was created.

4. Enter `db2 "select * from userid.QUOTE"`

5. Verify some sample data was loaded.

6. Enter `db2 connect to TRADE user db2admin using was1edu`

7. Enter `db2 list tables for schema userid`

8. Verify that the ACCOUNT, ADDRESS, HOLDINGS, PROFILE, SYMBOL and TRANSACTIONHISTORY tables were created.

9. Using select statements similar to above, verify that some sample data was loaded.

10. Enter `db2 disconnect current`
Appendix A. Additional setup instructions for IBM course “Ghost” images

In cases where one machine is ghosted and copied to other machines perform the actions in this Appendix.

**Before creating a ghost image**

If you are creating a ghost image perform the following actions before capturing the image.

___ 1. Log in as root using was1edu password.
___ 2. Set up the hostname (was6host00) for the loopback a IP address (127.0.0.1) in the hosts file.

**After loading a ghost image**

After loading the ghost image, you will not need to assign a unique hostname to each machine. Perform the following actions for each ghosted machine.

___ 1. Log in as root using was1edu password
___ 2. Ensure the hostname is was6host00. If it is not, change the hostname and restart the computer.
Requirements (Linux)

The following tables list the hardware, software, and other materials needed to set up a lab to conduct a class of course SW246 on Linux.

Hardware requirements

Table 8 lists the hardware needed to prepare one student lab set. When preparing for a class, multiply the items below by the number of lab sets needed for the class.

Table 8: Hardware for one student lab set

<table>
<thead>
<tr>
<th>Platform Use</th>
<th>Machine Requirements</th>
<th>Minimum Memory</th>
<th>Minimum Disk Space</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student</td>
<td>Pentium 1 Ghz</td>
<td>1 GB</td>
<td>12 GB</td>
<td>CD-ROM</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Network adapter</td>
</tr>
<tr>
<td>Instructor</td>
<td>Pentium 1 Ghz</td>
<td>1 GB</td>
<td>12 GB</td>
<td>CD-ROM</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Network adapter</td>
</tr>
</tbody>
</table>

Software requirements

Table 9 lists the software needed to prepare the student and instructor lab sets. When preparing for a class, be sure you have the correct number of licensed copies of any non-IBM software.

Table 9: Software for student and instructor systems

<table>
<thead>
<tr>
<th>Platform Use</th>
<th>Operating System</th>
<th>OS Version</th>
<th>Applications</th>
<th>Application Version</th>
<th>Licensing Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student</td>
<td>RedHat Fedora</td>
<td>Core 1</td>
<td>Mozilla Firefox</td>
<td>Version 1.x</td>
<td>GNU Public License</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ksh</td>
<td>20041225</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IBM DB2 UDB*</td>
<td>Version 8.2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(same as Version 8.1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>FixPak 7a)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IBM WebSphere Application Server Network Deployment *</td>
<td>V6 (as Installation Image)</td>
<td></td>
</tr>
</tbody>
</table>
Table 9: Software for student and instructor systems

<table>
<thead>
<tr>
<th>Platform Use</th>
<th>Operating System</th>
<th>OS Version</th>
<th>Applications</th>
<th>Application Version</th>
<th>Licensing Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Application Server Toolkit (AST) *</td>
<td>V 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Adobe Acrobat Reader</td>
<td>5.0 or above</td>
<td></td>
</tr>
<tr>
<td>Course Lab</td>
<td></td>
<td></td>
<td>SW246v6_software.zip</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SW246v6_software_CDsLinux.zip</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Instructor</td>
<td></td>
<td></td>
<td>Same as Student system</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Both Course Lab files are packaged as one zip file: *sw246labfiles_Linux.zip*.

* Follow your normal policies and procedures regarding obtaining licensed software. IBM employees may wish to use the Software Downloads section at Xtreme Leverage Portal (w3.ibm.com/software/websphere).

Search for “WebSphere Network Deployment V6.0 Linux” with All option selected.

Table 3 shows file names from the downloaded e-Assembly. If you are installing from CDs, use the appropriate installation disk instead.

Table 10: Main IBM software images

<table>
<thead>
<tr>
<th>File name</th>
<th>Part of WAS6 ND</th>
</tr>
</thead>
<tbody>
<tr>
<td>C80UMML.tar.gz</td>
<td>WebSphere Application Server Network Deployment V6.0 Application Server Toolkit for Linux, German Eng Intern'l Spanish French Italian Japanese Korean Port. Brazilian Chinese Simplified Chinese Traditional</td>
</tr>
<tr>
<td>C58S8ML.tar</td>
<td>DB2 UDB Enterprise Server Edition V8.2 for Linux for Intel 32-bit (English, French, German, Spanish, Italian, Brazilian Portuguese, Russian, Polish, Czech, Japanese, Korean, Simplified and Traditional Chinese)</td>
</tr>
</tbody>
</table>

Special materials requirements

This table lists the tools the instructor and students can use during the class. Quantities are specified for the entire class.
The WebSphere Help System is part of the SW246v6_software_CDsLinux.zip package.

To download the newest WebSphere Help System and the Offline InfoCenter Documentation go to the following Web site:

### Product documentation requirements

None

### Special materials requirements

None

### Skills required to set up the lab

The following specialized skills are required to set up the lab.

- Familiarity with installing Linux and DB2.

---

<table>
<thead>
<tr>
<th>Tools recommended</th>
<th>Tools</th>
<th>Files</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>WebSphere Help System</td>
<td>webSphere_help_system_212_linux.zip</td>
<td>V 2.1.2</td>
</tr>
<tr>
<td></td>
<td>WAS V6 ND DOC</td>
<td>com.ibm.websphere.nd.doc.zip</td>
<td>V6</td>
</tr>
<tr>
<td></td>
<td>IHS V6 DOC</td>
<td>com.ibm.websphere.ihs.doc.zip</td>
<td>V6</td>
</tr>
</tbody>
</table>
Setup instructions (Linux)

Configuration information

The following describes the configurations of the student and lab set systems.

The ideal classroom configuration is to have all student machines connected to the same LAN with TCP/IP correctly configured so that machines can connect to each other using their host names. Internet access is recommended.

If no LAN adapter is available, the Loopback Adapter (lo) should be configured as the default LAN adapter with a private TCP/IP address (127.0.0.1) so that the TCP/IP stack will be active.

Each student machine should be able to be used stand-alone and MUST have all of the products required for the labs installed locally.

Hardware setup instructions

No special instructions.

Software setup instructions

Use the following information in addition to the normal software installation procedures to set up the lab software. It is no longer necessary for student systems to communicate with each other for lab purposes so static IP addresses are no longer required. Connection to the internet is not required but may be desirable in some lab situations.

Install and configure Linux

1. During Linux installation:
   - Create a single partition and install RedHat Enterprise Edition or Fedora Core 1 as appropriate and all other products on this partition.
   - Set the password for root user to was1edu (lower case).
   - Use was6host00 for the computer name. Note: Do not include an underscore (_) character or other symbol characters in the computer name because this will result in an invalid TCP/IP host name and some products will fail.
   - Select DHCP as the IP connection type
   - During installation specify and confirm was1edu for the root password.
   - On the Package Group Selections screen, select, XWindow, GNOME, KDE, Editors, Graphical Internet, Test-based Internet, Office/Productivity, Server Configuration Tools, Windows File Server, FTP Server, Administration
Tools and Printing Support. Ensure that you DO NOT have Web Server selected.

- Ensure the monitor is setup for a minimum of 1024 X 768 resolution

2. If there is no LAN adapter, Linux will define a loopback adapter by default
   - Open a terminal window and invoke `ifconfig lo` to determine if the loopback adapter is already configured with an address of 127.0.0.1
   - Use the `cat` command to see the contents of the `/etc/hosts` file: `cat /etc/hosts`
     There should already be an entry of **127.0.0.1 localhost**. Add was6host00 to this line as another name for the loopback adapter (see step 3 below).

3. If there is a LAN adapter, use `ifconfig eth0` at the command line to determine if an IP address has been assigned by the DHCP server. Edit the hosts file and add an alias for your computer name to the loopback IP address if one is not already there.
   - Edit `/etc/hosts` with vi or some text editor.
   - Modify the loopback address line like the following:
     
     127.0.0.1 was6host00 localhost localhost.localdomain

4. If there is a connection to the internet, either use DHCP as in the original setup or, where no DHCP server exists, set up a static IP address and gateway with connection to a DNS server for access to internet resources. Instructions for setting up a static IP address follows:
   - Select the RedHat icon or Main Menu
   - Select System Tools
   - Select Network Device Control
   - Select the appropriate Network Device (probably the eth0 device)
   - Click the configure button
   - Under the Hardware tab ensure a device is listed - this is the LAN adapter
   - Under the DNS tab enter the DNS server IP address and verify the hostname is correct
   - Under the Hosts tab edit the hostname entries as appropriate to configure the correct IP addresses and hostnames
   - Under the Devices tab double click the appropriate device (probably eth0) to invoke the Ethernet Device Configuration pop-up
   - Select Statically Set IP Addresses: and enter the IP address, subnet mask, and default gateway address
   - Under the Hardware Device tab deselect the Bind to MAC Address and select OK
• After all of these changes select the **File** drop down from the **Network Device Control** menu and click save

• Select **Quit** from the **File** drop down menu

• **Activate** the device if not activated. **Deactivate** it and then **activate** it again if it is already activated

5. Use the **Users and Groups** applet in **RedHat Main Menu** to create user ids and groups

• Select the **System Settings** option from the **RedHat Main Menu**

• Select the **Users and Groups** option

• Click the **Add User** button

• Enter **userid** in the User Name field

• Enter **was1edu** in the Password and Confirm Password fields

• Accept all other defaults and Click **OK**

• Repeat this process for **db2admin/was1edu** and **mqm/was1edu**

**NOTE:** DB2 requires userids all caps whereas Fedora will not permit userids in all caps. Edit the **/etc/passwd** file and the **/etc/group** file to add the **USERID** uid and bypass the Fedora rules.

• Click the **Add Group** button

• Enter **mqbrkrs** and click **OK**

• **Click OK**

• Click the **File** menu and the **Quit** option

6. Install and setup Mozilla Firefox to connect through a local area without proxy unless otherwise specified/directed.

• Download Mozilla Firefox 1.x from http://www.mozilla.org to some temporary directory

• Run **gzip -c -d firefox-1.x.installer.tar.gz | tar xv** where 1.x is the appropriate version of Firefox

• This will create a **firefox-installer** directory in the temporary directory

• **cd** to this directory and enter **./firefox-installer** at the command line

• The following screen will appear:
Welcome to Mozilla Firefox

You are about to install Mozilla Firefox 1.0.

It is strongly recommended that you exit all instances of Mozilla Firefox before running this Setup program.

Click Cancel to quit Setup and then close any programs you have running. Click Next to continue the Setup program.

Click Next to continue installing Mozilla Firefox 1.0.

• Select forward

Software License Agreement

Terms and conditions for using this software.

Please read the following license agreement. Use the scroll bar to view the rest of this agreement.

FOR TRANSLATIONS OF THIS LICENSE INTO SELECTED LANGUAGES, PLEASE VISIT WWW.MOZILLA.ORG/LICENSING.

Mozilla Foundation
Mozilla Firefox End-User Software License Agreement

A source code version of certain Firefox browser functionality that you may use, modify and distribute is available to you free-of-charge from www.mozilla.org under the Mozilla Public License and other open source software licenses.

The accompanying executable code version of Mozilla Firefox and related documentation (the "Product") is made available to you under the terms of this Mozilla Firefox End-User Software License Agreement (the "Agreement"). By clicking the "Accept" button, or by installing or using the Mozilla Firefox browser, you are consenting to be bound by the Agreement. If you do not agree

• Accept the License Agreement
• Ensure the **Standard** radio button is selected and modify the **Destination Directory** to `/usr/local/firefox`

• Select **Forward** and then select **Install**

__7. Install Adobe Acrobat Reader with default or classic settings__

• Download and install Adobe Acrobat Reader for Linux

• Follow the instructions at http://www.mozilla.org/ to install the Acrobat plug-in to Mozilla or Mozilla Firefox as appropriate

__8. Remove Mozilla Icon from the Icon Panel and replace it with the FireFox icon__

• Right-click the Mozilla icon located to the right of the RedHat Main Menu Icon

• Select **Remove from Panel** to delete Mozilla icon from panel

• Right-click in an empty area of the panel and select **Add to Panel**

• Select **Launcher...**

• Enter **Firefox** in the Name and Generic Name fields

• Click **No Icon** button

• Browse over to `/usr/local/firefox/icons` and select **mozicon50.xpm file**

• Select **OK**

• Select **Close**

• Move new icon to right of RedHat icon by right-clicking on icon and selecting **Move** option
__9. Create Terminal launcher in Startup Panel
   • Right-click in an empty area of the panel and select Add to Panel
   • Select Launcher from Menu
   • Select System Tools
   • Select Terminal icon
   • Move the new icon to right of the printer icon as shown below

__10. Create Launcher on the Desktop for the Evals
   • Close any open browsers
   • Right click in the Desktop area
   • Select Create Launcher from pop-up
   • Enter Evals for both Name and Generic Name fields
   • Enter the following text
     in the Command field
   • Click the No Icon button
   • Browse over to /usr/local/firefox/icons/ and select mozicon50.xpm
   • Select OK
   • Select Close and double-click the new desktop launcher to test it.

**Install DB2 UDB V8.2**

For the correct level of JDBC support the labs require DB2 Enterprise Server Edition Version 8.2 (you can also use Version 8.1 with Fixpack 7a).
__1. Install DB2 V8.2. Run ./db2setup from CD-ROM or the <DB2 Install> directory
__2. Select Install Product from menu.
__4. After a few moments the setup wizard appears with Welcome screen. Click Next>.
__5. Accept the agreement terms. Click Next>.
__6. Choose a Typical installation to install the default components. Click Next>.
__7. After some seconds make sure, that Install DB2 Enterprise Server Edition on the computer is selected, click Next>.
__8. Accept defaults for domain and user name for the DB2 Administration Server and add the correct password was1edu:
   • Domain: leave blank
   • User name: dasusr1
   • Group name: dasadm1
   • Password: was1edu
   • Confirm password: was1edu
   • Click Next>

__9. Accept the default for creating a DB2 instance. Click Next>.

__10. Select the Single-Partition instance. Click Next>.

__11. Accept defaults for instance user name and add the correct password was1edu:
   • User name: db2inst1
   • Group name: db2grp1
   • Password: was1edu
   • Confirm password: was1edu
   • Click Next>

__12. Accept defaults for fenced user name and add the correct password was1edu:
   • User name: db2fenc1
   • Group name: db2fgrp1
   • Password: was1edu
   • Confirm password: was1edu
   • Click Next>

__13. Select Do Not Prepare Tools Catalog... option. Click Next>.

__14. Accept the default for Administration contact list location - Local and deselect Enable notification. Click Next>.

__15. Click OK to accept the Warning about Notification SMTP server.

__16. Select Defer the task until after installation is complete for Administration contact. Click Next>.

__17. Review the Start copying files screen, click Install. Click Finish when setup is completed.

__18. Exit First Steps Launchpad.

__19. Edit /root/.bashrc and add the following lines:

   # Setup DB2 environment for root user.
if [ -f /home/db2inst1/sqlib/db2profile ] ; then
  . /home/db2inst1/sqlib/db2profile
fi

20. Edit /root/.bash_profile and add the following 2 lines prior to the export statement

```
declare -rx PS1="\$PWD
\$LOGNAME@\h \$ "
```

This will place the path in the prompt above the command line for root in any new shells created in a terminal window.

21. Edit /etc/bashrc and locate the text [ "PS1" = "\s-\v\$ " ] &&

- Change the text after && to read:
  `PS1="\w\n\u@\h \$ "`

where there is a space after \h and another prior to the ending double-quotes. This will place the path above the prompt in any new terminal windows that are opened.

22. Edit /etc/group file to add members to the dasusr1 and db2ints1 groups.

- Open /etc/group file with a text editor
- Add group members at the right of the group name similar to the following:
  `db2inst1:x:[groupnumber]:root,userid,db2admin`
  `dasusr1:x:[groupnumber]:root,db2inst1,userid,db2admin`

23. Logout and log back in as root

**Install WebSphere Application Server ND V6 Application Server Toolkit V6 (AST)**

1. If installing from the gzip file, create a new temporary directory and place the file in it. Unzip/untar the file with:

```
gzip -c -d <filename>.tar.gz | tar xv
```

2. Invoke the ./setup command from the temporary directory or from the install CD

3. Click Next> on Welcome screen.

4. Accept the Software License Agreement. Click Next>.

5. Accept the default installation directory (/opt/IBM/WebSphere/AST). Click Next>.

6. Click Next> on the Summary page and install the product.

7. Click Finish and exit the installation.

8. Create a launcher for the desktop as above for the Evals using

   - AST as the Name and Generic Name
   - /opt/IBM/WebSphere/AST/ast as the command
   - /opt/IBM/WebSphere/AST/ast_big_icon.gif for the icon
Copy installation images and additional files

__1. As root create a new /usr/tempdir directory.

__2. Use the unzip command at the command line to expand the sw246labfiles_Linux.zip to the /usr/tempdir directory. There should be two zip files.

__3. Unzip the files and folders from the /usr/tempdir/SW246v6_software_CDsLinux.zip to the /usr folder. This will create the /usr/software_CDs folder.

__4. Copy the contents of the WebSphere Application Server ND V6.0 for Linux CD to the /usr/software_CDs/WAS6 directory. If you are using a zip file of the WebSphere Application Server ND V6.0 product, unpack the content to the /usr/software_CDs/WAS6/ directory.

__5. Check the WebSphere Help System in the /usr/software_CDs/HelpSystem/ folder:
   - webSphere_help_system_212_linux.zip
   - com.ibm.websphere.nd.doc.zip
   - com.ibm.websphere.ihs.doc.zip

   Note: If the files are not available, you can get them from: http://www.ibm.com/software/webservers/appserv/library.html and copy all file to the /usr/software_CDs/HelpSystem folder.

Install Korn shell from /usr/software_CDs/utils folder

If the Korn shell is not available on the version of Linux you are using (for example, it is not a standard part of Fedora Linux), install the rpm provided:

__1. CD to /usr/software_CDs/utils folder

__2. Run rpm -i ksh-20051225-1.i386.rpm from command line

__3. Create a symbolic link to make ksh available in the /usr/bin directory, as follows:
   
   cd /usr/bin
   ln -s /bin/ksh

Install sample files

__1. Unzip the lab files from the /usr/tempdir/SW246v6_software.zip to the /usr/ folder. This will create the /usr/software folder.

   Note: This should create a directory structure under /usr/software.

__2. Setup the sample database for the trade application by running the following batch files in the /usr/software/Databases directory:
   
   • CD to the /usr/software/Databases directory
• run `chmod 755 *.sh` at the command line to make the scripts executable
• `CreateDB.sh` script may have some extraneous white-space characters that will prevent it from running properly. Use `vi` to remove them if necessary.
• Run shell script `.CreateDB.sh` as root
• Check the `CreateDB.log` file to verify the databases were created and populated correctly.

**Verification procedures**

Use the following information to verify the installation and configurations of the lab and instructor systems.

1. At the commandline enter
   
   `db2 connect to QUOTE user db2admin using was1edu`

2. Enter `db2 list tables for schema userid`

3. Verify that the `QUOTE` table was created.

4. Enter `db2 "select * from userid.QUOTE"`

5. Verify some sample data was loaded.

6. Enter `db2 connect to TRADE user db2admin using was1edu`

7. Enter `db2 list tables for schema userid`

8. Verify that the `ACCOUNT, ADDRESS, HOLDINGS, PROFILE, SYMBOL` and `TRANSACTIONHISTORY` tables were created.

9. Using select statements similar to above, verify that some sample data was loaded.

10. Enter `db2 disconnect current`
Appendix A. Additional setup instructions for IBM course “Ghost” images

In cases where one machine is ghosted and copied to other machines perform the actions in this Appendix.

**Before creating a ghost image**

If you are creating a ghost image perform the following actions before capturing the image.

1. Log in as root using was1edu password.
2. Set up the hostname (was6host00) for the loopback a IP address (127.0.0.1) in the hosts file.

**After loading a ghost image**

After loading the ghost image, you will not need to assign a unique hostname to each machine. Perform the following actions for each ghosted machine.

1. At bootup time enter the BIOS and ensure that Video RAM is set to 8192 or the max available
2. Log in as root using was1edu password
3. Ensure the monitor hardware is setup properly for the monitor supplied with the CPU by entering the Display Applet found under System Settings.
4. Select the Settings tab where there should be a choice of resolutions including 1024 X 768. If this is not the case complete the next 2 steps
5. Select the Hardware tab and configure the monitor hardware with the correct monitor type by clicking on the Configure button and finding the correct monitor from the list.
6. Log out and log back in to engage the new settings and refire the XWindows engine.

**For Dell computers**

1. If the CPU is a Dell computer install an i810 chipset patch required for Dell systems to operate properly with RedHat. Change directories to /usr/software_CDsLinux/utils and run the following program:
   
   ```
   rpm -i 865patch-0.3-2.i386.rpm
   ```
2. Reboot the system and log in as root